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1 Welcome

Using script to automate the FTP operation

CodingFTP is a software to help you to automate the FTP transfers. You can easily upload file to FTP
server, download files from FTP server, change file permission. Do any FTP operation, automatically .

Note: CodingFTP isn't intend to be a replacement of traditional FTP client. It's designed for
unattended, repeat, automated tasks. You may still need a traditional FTP client for manually
operation.
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2 Script Language Introduction

When we talking about writing script, you may think it's difficult. However, Coding FTP provides
several

1) Easy to use script language
Coding FTP uses Java Script and Basic Script  syntax. They are both widely used script languages. 
You may already see them in Windows and web pages. It's almost no learning curve if you have any
programming experience.

2) Easy to use command option
Writing command in Coding FTP is likely writing command line  in DOS window. Coding FTP uses
similar syntax.

For example, to establish a FTP connection, you can use following command in script:
OpenHost( "/host=127.0.0.1 /username=myusername /passwd=mypasswd" );

As you can see, it's very similar to write a command line.

3) Script Wizard
Coding FTP also has an easy to use Script Wizard to help you write the script. You can open it in the
main window of Coding FTP.
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3 Where to start?

1) Firstly, you may want to see or run some script samples so that you can have the first
impression on Coding FTP
You can open the sample scripts from the Basic Script Samples  and Java Script Samples
categories in Script Library.

2) Then, you can use Coding FTP Script Wizard to help you write some simple scripts.
You can open the wizard by clicking "File->New->Open Script Wizard"; Or, press Ctrl+W.
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4 Script Command

CodingFTP has about 20 commands. You can use them in the script to do any FTP operations.
Coding FTP uses Java/VB Script syntax for all commands. It's almost no learning curve if you have
programming knowledge.

We also provide Script Writing Service if you have no any knowledge about coding or you simply don't
want to take time to write the script. For either case, we are glad to write the script for you at a
reasonable fee. More information about the SWS, please refer to Script Writing Service section.

4.1 Script Sample

Let's see a simple example which demonstrates how to establish the connection with a FTP server.
You can also open them from "Java Script Samples" and "Basic Script Samples" in Script Library.

JScript Example:
����
�8�L�M�W���W�G�V�M�T�X���H�I�Q�S�R�W�X�V�E�X�I�W���L�S�[���X�S���Y�W�I���'�S�H�M�R�K�*�8�4���X�S���G�S�R�R�I�G�X���X�S���E���*�8�4���W�I�V�Z�I�V��
�-�X���[�M�P�P���X�V�]���Y�T���X�S���X�L�V�I�I���X�M�Q�I�W�����=�S�Y���Q�E�]���R�I�I�H���X�S���G�L�E�R�K�I���L�S�W�X���E�H�H�V�I�W�W���E�R�H���E�G�G�S�Y�R�X���M�R�J�S�V�Q�E�X�M�S�R��
����
hostaddr = "localhost" ;
username = "anonymous" ;
passwd = "";
connected = false;
retrytimes = 1;

connected = OpenHost ( "/host=$hostaddr /username=$username /passwd=$passwd" );

�[�L�M�P�I ( !connected && (retrytimes <= 3) )
{

WriteLog ( "Retrying..."  + ToStr (retrytimes));
Sleep ( "/s=2" ); �������7�P�I�I�T�������W�I�G�S�R�H�W���E�R�H���V�I�X�V�]����

  retrytimes++;
  connected = OpenHost ( "/host=$hostaddr /username=$username /passwd=$passwd" );
}

if (connected)
{

WriteLog ( "Connected successfully!" );
CloseHost ;

}
else
{

WriteLog ( "Connection failed, error message: "  + ErrorText);
}

Basic Script Example:
���8�L�M�W���W�G�V�M�T�X���H�I�Q�S�R�W�X�V�E�X�I�W���L�S�[���X�S���Y�W�I���'�S�H�M�R�K�*�8�4���X�S���G�S�R�R�I�G�X���X�S���E���*�8�4���W�I�V�Z�I�V��
���-�X���[�M�P�P���X�V�]���Y�T���X�S���X�L�V�I�I���X�M�Q�I�W�����=�S�Y���Q�E�]���R�I�I�H���X�S���G�L�E�R�K�I���L�S�W�X���E�H�H�V�I�W�W���E�R�H���E�G�G�S�Y�R�X���M�R�J�S�V�Q�E�X�M�S�R��
hostaddr = "localhost"
username = "anonymous"
passwd = ""
connected = false
retrytimes = 1

connected = OpenHost ( "/host=$hostaddr /username=$username /passwd=$passwd" )

while ( not connected and (retrytimes <= 3) )
WriteLog ( "Retrying..."  & ToStr (retrytimes))
Sleep ( "/s=2" )

  retrytimes = retrytimes + 1
  connected = OpenHost ( "/host=$hostaddr /username=$username /passwd=$passwd" )
wend

if (connected) then
WriteLog ( "Connected successfully!" )
CloseHost
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else
WriteLog ( "Connection failed, error message: "  & ErrorText)

end if

4.2 Connection

�x INITServerInfo
�x OpenHost
�x CloseHost

4.2.1 INITServerInfo

Description:
Initializing server information

Options:
/tz Time zone of FTP server. Available values: 

auto : If it's the first time to connect to the FTP serve, CodingFTP will use detect option to
check it's timezone; Otherwise, CodingFTP will use stroed timezone
detect : CodingFTP always try to detect the time zone of FTP server.
a specified time zone : You can also specify the time zone directly if you know it.

/timeaccuTime accuracy. How CodingFTP compares file timestamp. Available values:
auto : If your FTP server supports MLST command, CodingFTP uses "second" accuracy;
otherwise, "minute" accuracy will be used
m: Minute accuracy. 20:12:15 is equal to 20:12:40
s: Second accuracy. 20:12:15 is older than 20:12:40

Default Option: 
/tz=auto
/timeaccu=auto

JScript Example:
INITServerInfo(" /tz=auto /timeaccu=m" ); �������(�I�X�I�G�X�M�R�K���*�8�4���W�I�V�Z�I�V���X�M�Q�I�^�S�R�I���E�Y�X�S�Q�E�X�M�G�E�P�P�]�����9�W�M�R�K���Q�M�R�Y�X�I���E�G�G�Y�V�E�G�]

Basic Script Example:
INITServerInfo("/tz=auto /timeaccu=m") �����(�I�X�I�G�X�M�R�K���*�8�4���W�I�V�Z�I�V���X�M�Q�I�^�S�R�I���E�Y�X�S�Q�E�X�M�G�E�P�P�]�����9�W�M�R�K���Q�M�R�Y�X�I���E�G�G�Y�V�E�G�]

See Also:

4.2.2 OpenHost

Description:
Establish connection with a FTP server

Options:
/host FTP server address

/port FTP server port. Default value is 21, you don't need to change it in most cases

/
usernam
e

Username on the FTP server

/passwd Password of above user

/site Site ID/Name in Site Manager
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/account Account ID/Name in Site Manager

Remark:
Normally, if you only need to connect to a non-secure FTP server, you can simply use following
parameters in command:
" /host=127.0.0.1 /username=John /passwd=mypasswd"

However, if you need to connect to a secure FTP server or you need to use proxy, etc. You need to
use the /site and /account. e.g.
" /site=mysite /account=myaccount"

The mysite and myaccount are the user defined Site/Account in Site Manager. To launch Site
Manager, please click "Edit->FTP Site Manager" on main window of Coding FTP

JScript Example:
OpenHost(" /host=127.0.0.1 /username=John /passwd=mypasswd" );

Basic Script Example:
OpenHost("/host=127.0.0.1 /username=John /passwd=mypasswd")

See Also:
CloseHost

4.2.3 CloseHost

Description:
Close the connection from a FTP server

Options:
(no
option)

JScript Example:
�M�J ( OpenHost(" /host=127.0.0.1 /anonymous" ) )
  CloseHost;

Basic Script Example:
If  OpenHost("/host=127.0.0.1 /anonymous") Then
  CloseHost

See Also:
OpenHost

4.3 File Operation

4.3.1 DownloadFile

Description:
Downloading file(s) from FTP server. The file downloading is a basic and important feature for FTP
operation. CodingFTP provides a very convenient way to download file(s)

Options:
/ftp File(s) need to be downloaded. A single file or a path with wildcard.
/localdir A directory on local computer to store files
/subdirs Including sub directories if specified
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/
newname

New file name on local disk

/ifnewer Download file only when FTP file newer than local copy
/iflarger Download file only when FTP file larger than local copy
/ifnotexistDownload file only when it's not exists in local computer
/flat Download files from FTP server and store all of them in local directory without sub directory
/exclude Exclusion filter
/crc Using XCRC command to verify files after downloading, make sure all files were downloaded

successfully

Result:
Boolean value
True : All files were downloaded successfully or no file was downloaded
False : Error occurred when download files

JScript Example:
�������(�S�[�R�P�S�E�H���E�P�P���J�M�P�I�W���Y�R�H�I�V�������Y�W�I�V���P�I�[�M�W���L�X�Q�P�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P��
DownloadFile(" ���I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���
���
�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�����V�X�E�G�L�U�V��);

�������(�S�[�R�P�S�E�H���E�P�P�����N�T�K�����J�M�P�I�W���Y�R�H�I�V�������Y�W�I�V���P�I�[�M�W���L�X�Q�P�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W��
DownloadFile(" ���I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���
���M�S�J�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�����V�X�E�G�L�U�V");

�������(�S�[�R�P�S�E�H���J�M�P�I�������Y�W�V�W���P�I�[�M�W���L�X�Q�P���Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�@�Q�E�M�R�[�M�R�H�S�[���N�T�K��
DownloadFile(" ���I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V");

�������(�S�[�R�P�S�E�H���J�M�P�I�������Y�W�V�W���P�I�[�M�W���L�X�Q�P���Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�����E�R�H���V�I�R�E�Q�I���M�X���X�S�����F�E�G�O�Y�T���N�T�K��
DownloadFile(" ���I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�����Q�H�Z�Q�D�P�H� �E�D�F�N�X�S���M�S�J");

Basic Script Example:
�����(�S�[�R�P�S�E�H���E�P�P���J�M�P�I�W���Y�R�H�I�V�������Y�W�I�V���P�I�[�M�W���L�X�Q�P�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P��
�'�R�Z�Q�O�R�D�G�)�L�O�H�������I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���
���
�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�����V�X�E�G�L�U�V����

�����(�S�[�R�P�S�E�H���E�P�P�����N�T�K�����J�M�P�I�W���Y�R�H�I�V�������Y�W�I�V���P�I�[�M�W���L�X�Q�P�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W��
�'�R�Z�Q�O�R�D�G�)�L�O�H�������I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���
���M�S�J�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�����V�X�E�G�L�U�V����

�����(�S�[�R�P�S�E�H���J�M�P�I�������Y�W�V�W���P�I�[�M�W���L�X�Q�P���Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�@�Q�E�M�R�[�M�R�H�S�[���N�T�K��
�'�R�Z�Q�O�R�D�G�)�L�O�H�������I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V����

�����(�S�[�R�P�S�E�H���J�M�P�I�������Y�W�V�W���P�I�[�M�W���L�X�Q�P���Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�����E�R�H���V�I�R�E�Q�I���M�X���X�S�����F�E�G�O�Y�T���N�T�K��
�'�R�Z�Q�O�R�D�G�)�L�O�H�������I�W�S� ���X�V�U�V���O�H�Z�L�V���K�W�P�O���P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����O�R�F�D�O�G�L�U� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�����Q�H�Z�Q�D�P�H� �E�D�F�N�X�S���M�S�J����

See Also:
UploadFile, SyncDir

4.3.2 UploadFile

Description:
Uploading file(s) to FTP server. The file Uploading is a basic and important feature for FTP operation.
CodingFTP provides a very convenient way to Upload file(s)

Options:
/local File(s) need to be uploaded. A single file or a path with wildcard.
/ftpdir A directory on FTP server to store files
/subdirs Including sub directories if specified
/
newname

New file name on FTP server

/ifnewer Upload file only when local file is new than the copy on FTP server
/iflarger Upload file only when local file is larger than the copy on FTP server
/ifnotexistUpload file only when it's not exists on FTP server
/flat Upload files to FTP server and store all of them in remote directory without sub directory
/hidden Upload hidden files
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/sys Upload sys files
/exclude Exclusion filter
/crc Using XCRC command to verify files after downloading, make sure all files were downloaded

successfully
/emptydir Create directory on FTP server even if local directory is empty

JScript Example:
�������9�T�P�S�E�H���E�P�P���J�M�P�I�W���Y�R�H�I�V�����H���@�X�I�Q�T�@�L�X�Q�P�����X�S�������Y�W�I�V���P�I�[�M�W���L�X�Q�P��
UploadFile(" ���O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�
���
�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O�����V�X�E�G�L�U�V");

�������9�T�P�S�E�H���E�P�P�����N�T�K�����J�M�P�I�W���Y�R�H�I�V�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�����X�S�������Y�W�I�V���P�I�[�M�W���L�X�Q�P��
UploadFile(" ���O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�?�
���M�S�J�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O�����V�X�E�G�L�U�V");

�������9�T�P�S�E�H���J�M�P�I�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�@�Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�������Y�W�V�W���P�I�[�M�W���L�X�Q�P���Q�E�M�R�[�M�R�H�S�[���N�T�K��
UploadFile(" ���O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�?�P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O");

�������9�T�P�S�E�H���J�M�P�I�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�@�Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�������Y�W�V�W���P�I�[�M�W���L�X�Q�P�����E�R�H���V�I�R�E�Q�I���M�X���X�S�����F�E�G�O�Y�T���N�T�K��
UploadFile(" ���O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�?�P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O�������Q�H�Z�Q�D�P�H� �E�D�F�N�X�S���M�S�J");

Basic Script Example:
�����9�T�P�S�E�H���E�P�P���J�M�P�I�W���Y�R�H�I�V�����H���@�X�I�Q�T�@�L�X�Q�P�����X�S�������Y�W�I�V���P�I�[�M�W���L�X�Q�P��
�8�S�O�R�D�G�)�L�O�H�������O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�
���
�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O�����V�X�E�G�L�U�V����

�����9�T�P�S�E�H���E�P�P�����N�T�K�����J�M�P�I�W���Y�R�H�I�V�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�����X�S�������Y�W�I�V���P�I�[�M�W���L�X�Q�P��
�8�S�O�R�D�G�)�L�O�H�������O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�?�
���M�S�J�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O�����V�X�E�G�L�U�V����

�����9�T�P�S�E�H���J�M�P�I�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�@�Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�������Y�W�V�W���P�I�[�M�W���L�X�Q�P���Q�E�M�R�[�M�R�H�S�[���N�T�K��
�8�S�O�R�D�G�)�L�O�H�������O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�?�P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O����

�����9�T�P�S�E�H���J�M�P�I�����H���@�X�I�Q�T�@�L�X�Q�P�@�N�T�K�W�@�Q�E�M�R�[�M�R�H�S�[���N�T�K�����X�S�������Y�W�V�W���P�I�[�M�W���L�X�Q�P�����E�R�H���V�I�R�E�Q�I���M�X���X�S�����F�E�G�O�Y�T���N�T�K��
�8�S�O�R�D�G�)�L�O�H�������O�R�F�D�O� �G���?�W�H�P�S�?�K�W�P�O�?�M�S�J�V�?�P�D�L�Q�Z�L�Q�G�R�Z���M�S�J�����I�W�S�G�L�U� ���X�V�U�V���O�H�Z�L�V���K�W�P�O�������Q�H�Z�Q�D�P�H� �E�D�F�N�X�S���M�S�J����

See Also:
DownloadFile, SyncDir

4.3.3 SyncDir

Description:
Keep local directory and FTP directory in sync

Options:
/localdir A directory on local computer
/ftpdir A directory on FTP server
/
syncmeth
od

How to synchronize files? Possible values:

updateft
p

Upload all new and changed files to FTP server

updatede
lftp

Upload all new and changed files to FTP server and delete all obsolete files from
FTP server

updatelo
cal

Download all new and changed files to local computer

updatede
llocal

Download all new and changed files to local computer and delete all obsolete files
from local computer

bisync
/subdirs Including sub directories if specified
/include Inclusion filter. Only files in inclusion filter will be transferred
/exclude Inclusion filter. All files in exclusion filter will NOT be transferred
/fastsync Using fast sync to speed up the sync process. If this option enabled, you should not manually

upload/edit files on FTP server as CodingFTP is not aware to these changes and this may
cause conflict.
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/crc Using XCRC command to verify the files to make sure they were uploaded/downloaded
successfully

JScript Example:
�������9�T�P�S�E�H���E�P�P���G�L�E�R�K�I�H���J�M�P�I���X�S�������Y�W�I�V�W���P�I�[�M�W���L�X�Q�P�W�����E�R�H���Z�I�V�M�J�]���X�L�I�]���[�I�V�I���W�]�R�G�L�V�S�R�M�^�I�H���W�Y�G�G�I�W�W�J�Y�P�P�]
SyncDir(" ���O�R�F�D�O�G�L�U� �G���?�O�H�Z�L�V�?�K�W�P�O�V�����I�W�S�G�L�U� ���X�V�H�U�V���O�H�Z�L�V���K�W�P�O�V�����V�\�Q�F�P�H�W�K�R�G� �X�S�G�D�W�H�I�W�S�����V�X�E�G�L�U�V�����F�U�F");

Basic Script Example:
�����9�T�P�S�E�H���E�P�P���G�L�E�R�K�I�H���J�M�P�I���X�S�������Y�W�I�V�W���P�I�[�M�W���L�X�Q�P�W�����E�R�H���Z�I�V�M�J�]���X�L�I�]���[�I�V�I���W�]�R�G�L�V�S�R�M�^�I�H���W�Y�G�G�I�W�W�J�Y�P�P�]
�6�\�Q�F�'�L�U�������O�R�F�D�O�G�L�U� �G���?�O�H�Z�L�V�?�K�W�P�O�V�����I�W�S�G�L�U� ���X�V�H�U�V���O�H�Z�L�V���K�W�P�O�V�����V�\�Q�F�P�H�W�K�R�G� �X�S�G�D�W�H�I�W�S�����V�X�E�G�L�U�V�����F�U�F������

See Also:
DownloadFile, UploadFile

4.3.4 SetSpeed

Description:
Set transferring speed

Options:
/kb Max speed in KB

/mb Max speed in MB

Default Option:
No speed limitation.

JScript Example:
SetSpeed(" /kb=60" ); �������W�I�X���Q�E�\���Y�T�P�S�E�H�M�R�K���H�S�[�R�P�S�E�H�M�R�K���X�S�������O�F���W�I�G�S�R�H

Basic Script Example:
SetSpeed("/kb=60") �����W�I�X���Q�E�\���Y�T�P�S�E�H�M�R�K���H�S�[�R�P�S�E�H�M�R�K���X�S�������O�F���W�I�G�S�R�H

See Also:

4.3.5 SetTransferMode

Description:
Set transferring mode.

Options:
/binary Using binary mode to transfer all files in 'exts'. Other files will be transferred in ascii mode. If

'exts' option isn't  used, all files will be transferred in binary mode.
/ascii Using ascii mode to transfer all files in 'exts'. Other files will be transfered in binary mode. If

'exts' option isn't  used, all files will be transferred in ascii mode.
/exts File extension list. 

Default Option: 
"binary", all files will be transferred in binary mode.

JScript Example:
SetTransferMode(" /binary "); �������9�W�M�R�K���F�M�R�E�V�]���Q�S�H�I���X�S���X�V�E�R�W�J�I�V���E�P�P���J�M�P�I�W
SetTransferMode(" /ascii /exts=*.txt;*.html;*.php "); �������9�W�M�R�K���E�W�G�M�M���Q�S�H�I���X�S���X�V�E�R�W�J�I�V�������X�\�X���������L�X�Q�P���E�R�H�������T�L�T���J�M�P�I�W�����3�X�L�I�V���J�M�P�I�W���[�M�P�P���F�I���X�V�E�R�W�J�I�V�V�I�H���M�R���F�M�R�E�V�]���Q�S�H�I��

Basic Script Example:
SetTransferMode("/binary") �����9�W�M�R�K���F�M�R�E�V�]���Q�S�H�I���X�S���X�V�E�R�W�J�I�V���E�P�P���J�M�P�I�W
SetTransferMode("/ascii /exts=*.txt;*.html;*.php") �����9�W�M�R�K���E�W�G�M�M���Q�S�H�I���X�S���X�V�E�R�W�J�I�V�������X�\�X���������L�X�Q�P���E�R�H�������T�L�T���J�M�P�I�W�����3�X�L�I�V���J�M�P�I�W���[�M�P�P���F�I���X�V�E�R�W�J�I�V�V�I�H���M�R���F�M�R�E�V�]���Q�S�H�I��
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See Also:

4.3.6 SetFileDate

Description:
Change file timestamp

Options:
/local A local file
/ftp A ftp file
/date New modification time

Result:
Boolean value
True : Successfully updated file timestamp
False : Failed to update file timestamp

JScript Example:
�M�J ( SetFileDate(" /ftp=/users/lewis/1.jpg /date=2008-3-10 13:23:40 ") )
�_
  WriteLog(" Update file timestamp successfully ");
�a
�I�P�W�I
�_
  WriteLog(" Failed to update file timestamp ");
}

Basic Script Example:
If  SetFileDate("/ftp=/users/lewis/1.jpg /date=2008-3-10 13:23:40") Then
  WriteLog("Update file timestamp successfully")
Else
  WriteLog("Failed to update file timestamp")
End If

See Also:

4.3.7 SizeDiff

Description:
Compare the size of two files

Options:
/file1 Full path of file1
/file2 Full path of file 2

Result:

larger File1 is larger than file2; Or file2 isn't existing.
equal The size of file1 and file2 are equal
smaller File1 is smaller than file2; Or file1 isn't existing.
unknow
n

Error occurred. e.g. unable to get file size

JScript Example:
�M�J ( SizeDiff( �����I�L�O�H��� �G���?�W�H�P�S�?�����M�S�J�����I�L�O�H��� ���X�V�H�U�V���O�H�Z�L�V�������M�S�J��) == "larger"  )
{
  WriteLog( "1.jpg is larger" );
}
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�M�J ( SizeDiff( "/file1=/users/lewis/2.jpg /file2=/users/lewis/1.jpg" ) == "smaller"  )
{
  WriteLog( "2.jpg is smaller" );
}

Basic Script Example:
If ���6�L�]�H�'�L�I�I�������I�L�O�H��� �G���?�W�H�P�S�?�����M�S�J�����I�L�O�H��� ���X�V�H�U�V���O�H�Z�L�V�������M�S�J������� �����O�D�U�J�H�U����Then
  WriteLog("1.jpg is larger")
End If

If  SizeDiff("/file1=/users/lewis/2.jpg /file2=/users/lewis/1.jpg") = "smaller" Then
  WriteLog("2.jpg is smaller")
End If

See Also:
TimeDiff

4.3.8 TimeDiff

Description:
Compare the timestamp of two files

Options:
/file1 Full path of file1
/file2 Full path of file 2

Result:

newer File1 is newer than file2; Or file2 isn't existing.
equal The timestamps of file1 and file2 are equal
older File1 is older than file2; Or file1 isn't existing.
unknow
n

Error occurred. e.g. unable to get file timestamp

JScript Example:
�M�J ( TimeDiff( �����I�L�O�H��� �G���?�W�H�P�S�?�����M�S�J�����I�L�O�H��� ���X�V�H�U�V���O�H�Z�L�V�������M�S�J��) == "newer"  ) 
{
  WriteLog( "1.jpg is newer" );
}

�M�J ( TimeDiff( "/file1=/users/lewis/2.jpg /file2=/users/lewis/1.jpg" ) == "older" )
{
  WriteLog( "2.jpg is older" );
}

Basic Script Example:
If ���7�L�P�H�'�L�I�I�������I�L�O�H��� �G���?�W�H�P�S�?�����M�S�J�����I�L�O�H��� ���X�V�H�U�V���O�H�Z�L�V�������M�S�J������� �����Q�H�Z�H�U����Then
  WriteLog("1.jpg is newer")
End If

If  TimeDiff("/file1=/users/lewis/2.jpg /file2=/users/lewis/1.jpg") = "older" Then
  WriteLog("2.jpg is older")
End If

See Also:
SizeDiff

4.3.9 FileExists

Description:
Checking whether a specified file exists
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Options:

/path A file on local computer or FTP server

Result:
True or False

JScript Example:
�M�J ( FileExists( "/ftp=/users/lewis/1.jpg" ) )
{
  WriteLog( "File exists" );
}
�I�P�W�I
{
  WriteLog( "File not exists" );
}

Basic Script Example:
If  FileExists("/ftp=/users/lewis/1.jpg") Then
  WriteLog("File exists")
Else
  WriteLog("File not exists")
End If

See Also:
DirExists

4.3.10 DirExists

Description:
Checking whether a specified directory exists

Options:

/path A directory on local computer or FTP server

Result:
True or False

JScript Example:
�M�J ( DirExists( "/ftp=/users/lewis" ) )
{
  WriteLog( "Directory exists" );
}
�I�P�W�I
{
  WriteLog( "Directory not exists" );
}

Basic Script Example:
If  DirExists("/ftp=/users/lewis") Then
  WriteLog("Directory exists")
Else
  WriteLog("Directory not exists")
End If

See Also:
FileExists, CreateDir, DelDir
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4.3.11 Rename

Description:
Rename a file 

Options:
/oldpath Origional file
/newpath New file name. If the path specified, the file may moved to new location.

JScript Example:
�������6�I�R�E�Q�I���*�8�4���J�M�P�I�������Y�W�I�V�W���P�I�[�M�W���X�I�Q�T�������N�T�K�����X�S�������Y�W�I�V�W���P�I�[�M�W���X�I�Q�T�������N�T�K��
Rename("/oldpath=/users/lewis/temp/1.jpg /newpath=2.jpg" );

�������6�I�R�E�Q�I���P�S�G�E�P���J�M�P�I�����H���@�X�I�Q�T�@�����N�T�K�����X�S���������N�T�K�����E�R�H���Q�S�Z�I���M�X���X�S�����H���@�X�I�Q�T�@�F�E�G�O�Y�T�����H�M�V�I�G�X�S�V�]
Rename(�����R�O�G�S�D�W�K� �G���?�W�H�P�S�?�����M�S�J�����Q�H�Z�S�D�W�K� �G���?�W�H�P�S�?�E�D�F�N�X�S�?�����M�S�J��);

Basic Script Example:
�����6�I�R�E�Q�I���*�8�4���J�M�P�I�������Y�W�I�V�W���P�I�[�M�W���X�I�Q�T�������N�T�K�����X�S�������Y�W�I�V�W���P�I�[�M�W���X�I�Q�T�������N�T�K��
Rename("/oldpath=/users/lewis/temp/1.jpg /newpath=2.jpg")

�����6�I�R�E�Q�I���P�S�G�E�P���J�M�P�I�����H���@�X�I�Q�T�@�����N�T�K�����X�S���������N�T�K�����E�R�H���Q�S�Z�I���M�X���X�S�����H���@�X�I�Q�T�@�F�E�G�O�Y�T�����H�M�V�I�G�X�S�V�]
�5�H�Q�D�P�H�������R�O�G�S�D�W�K� �G���?�W�H�P�S�?�����M�S�J�����Q�H�Z�S�D�W�K� �G���?�W�H�P�S�?�E�D�F�N�X�S�?�����M�S�J������

4.3.12 SetFilePermission

Description:
Change file permission on FTP server

Options:

/ftp A file on FTP server
/
permissio
n

New permission string. 
There are 9 characters in the string. They represent owner permission, group permission
and other permission. Every permission has three characters.
e.g. rwxr-xr-- means: the owner can read/write/execute, the group can read/execute, and
others can only read

Result:
Boolean value: True or False

JScript Example:
�M�J ( SetFilePermission( "/ftp=/users/lewis/1.jpg /permission=rwxr--r--" ) )
{
  WriteLog( "Update file permission successfully" );
}
�I�P�W�I
{
  WriteLog( "Failed to update file permission" );
}

Basic Script Example:
If  SetFilePermission("/ftp=/users/lewis/1.jpg /permission=rwxr--r--") Then
  WriteLog("Update file permission successfully")
Else
  WriteLog("Failed to update file permission")
End If

See Also:
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4.3.13 CreateDir

Description:
Create a new directory on local computer or FTP server

Options:

/path Directory name or full path

Result:
Boolean value: True or False

JScript Example:
�M�J ( CreateDir( "/path=/users/lewis/newfolder" ) )
{
  WriteLog( "Successfully created directory" );
}
�I�P�W�I
{
  WriteLog( "Failed to create directory" );
}

Basic Script Example:
If  CreateDir("/path=/users/lewis/newfolder") Then
  WriteLog("Successfully created directory")
Else
  WriteLog("Failed to create directory")
End If

See Also:
DelDir

4.3.14 DelFile

Description:
Delete a file from local computer or FTP server

Options:
/localfile A single file or a path with wildcard
/ftpfile A single FTP file or a FTP path with wildcard
/subdirs Delete files in sub directories too if specified

JScript Example:
�������(�I�P�I�X�I���E�P�P���J�M�P�I�W���M�R���P�S�G�E�P���H�M�V�I�G�X�S�V�]���H���@�X�I�Q�T
DelFile( �����O�R�F�D�O�I�L�O�H� �G���?�W�H�P�S�?�
���
�����V�X�E�G�L�U�V��);

�������(�I�P�I�X�I���E�P�P���������X�Q�T�����M�R���*�8�4���H�M�V�I�G�X�S�V�]�������Y�W�I�V�W���P�I�[�M�W�������V�I�G�Y�V�W�M�Z�I�P�]
DelFile( "/ftpfile=/users/lewis/temp/*.tmp /subdirs" );

Basic Script Example:
�����(�I�P�I�X�I���E�P�P���J�M�P�I�W���M�R���P�S�G�E�P���H�M�V�I�G�X�S�V�]���H���@�X�I�Q�T
�'�H�O�)�L�O�H�������O�R�F�D�O�I�L�O�H� �G���?�W�H�P�S�?�
���
�����V�X�E�G�L�U�V����

�����(�I�P�I�X�I���E�P�P���������X�Q�T�����M�R���*�8�4���H�M�V�I�G�X�S�V�]�������Y�W�I�V�W���P�I�[�M�W�������V�I�G�Y�V�W�M�Z�I�P�]
DelFile("/ftpfile=/users/lewis/temp/*.tmp /subdirs")

See Also:
DownloadFile, UploadFile
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4.3.15 DelDir

Description:
Delete a directory from local computer or FTP server

Options:

/path Directory name or full path

Result:
True or False

JScript Example:
�M�J ( DelDir( "/path=/users/lewis/newfolder" ) )
{
  WriteLog( "Successfully deleted" );
}
�I�P�W�I
{
  WriteLog( "Failed to delete directory" );
}

Basic Script Example:
If  DelDir("/path=/users/lewis/newfolder") Then
  WriteLog("Successfully deleted")
Else
  WriteLog("Failed to delete directory")
End If

See Also:
CreateDir

4.3.16 UISelectFile

Description:
Display a standard file selection window so users can select a file

Options:

/title Window title. If not specified, the title will be "Please select a file"

JScript Example:
UISelectFile( "/title=Please select another file" );

Basic Script Example:
UISelectFile("/title=Please select another file")
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See Also:
UISelectDir

4.3.17 UISelectDir

Description:
Display a standard directory selection window so users can select a directory

Options:

/title Window title. If not specified, the title will be "Please select a directory"
/default Default directory

JScript Example:
UISelectFile( "/title=Please select another file" );

Basic Script Example:
UISelectFile("/title=Please select another file")
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See Also:
UISelectFile

4.4 Log & Notification

4.4.1 INITLogOption

Description:
Initialize log options

Options:

/path Log file name or full path. If only file name specified. The log file will be saved in the default
log directory.
For 2000/XP, the default directory is: C:\Documents and Settings\<User Name>\Application
Data\CodingFTP\Log
For Vista, the default directory is: C:\Users\<User Name>\AppData\Roaming\CodingFTP
\Logs

You can use following variables in the option:
%
SCRIPTN
AME%

Script file name

%
YEAR2%

Year in 2 digits. e.g. 08

%
YEAR4%

Year in 4 digits. e.g.2008

%MONTH Month with one digit before Oct, two digits after Oct. e.g. 1 and 12



CodingFTP Help28

�‹�������������)�H�Y�R�V�R�I�W

%
%
MONTH2
%

Month with two digits always. e.g. 01 and 12

%DAY% Use one digit if possible. e.g. 1 and 20
%DAY2% Always use two digits. e.g. 01 and 20
%HOUR% Use one digit if possible. e.g. 1 and 12
%
HOUR2%

Always use two digits. e.g. 01 and 12

%MINUTE
%

Use one digit if possible. e.g. 1 and 12

%
MINUTE2
%

Always use two digits. e.g. 01 and 12

%
SECOND
%

Use one digit if possible. e.g. 1 and 12

%
SECOND2
%

Always use two digits. e.g. 01 and 12

/size Max log file size, in MB. 
/overwriteOverwrite old log file
/onlyerror Only write error to the log file. As default, all information will be written to log file

JScript Example:
�������M�J���G�Y�V�V�I�R�X���H�E�X�I���M�W���������������������������������������W�G�V�M�T�X���R�E�Q�I���M�W���X�I�W�X�M�R�K�����X�L�I�R���X�L�I���P�S�K���J�M�P�I���R�E�Q�I���[�M�P�P���F�I�����X�I�W�X�M�R�K�����������������������������������P�S�K��
INITLogOption(" /path=%SCRIPTNAME%-%YEAR4%%MONTH2%%DAY2%-%HOUR2%%MINUTE2%%SECOND2% /size=10 /onlyerror");

Basic Script Example:
�����M�J���G�Y�V�V�I�R�X���H�E�X�I���M�W���������������������������������������W�G�V�M�T�X���R�E�Q�I���M�W���X�I�W�X�M�R�K�����X�L�I�R���X�L�I���P�S�K���J�M�P�I���R�E�Q�I���[�M�P�P���F�I�����X�I�W�X�M�R�K�����������������������������������P�S�K��
INITLogOption("/path=%SCRIPTNAME%-%YEAR4%%MONTH2%%DAY2%-%HOUR2%%MINUTE2%%SECOND2% /size=10 /onlyerror")

See Also:

4.4.2 WriteLog

Description:
Write log

Options:
(no
option)

JScript Example:
WriteLog(" My testing message" );

Basic Script Example:
WriteLog("My testing message")

See Also:
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4.4.3 SendEmail

Description:
Sending email

Options:

/subject Subject
/to Recipient address
/fname "From" name
/faddr "From" email address
/body Email body
/bodyfile You can also put message to a local file, CodingFTP will load it when sending out email

Note:
You need to specify the SMTP server information at "Edit->Options->Email Account" before using this
command.

JScript Example:
SendEmail(" /subject=Testing message from CodingFTP /to=user1@abc.com /fname=lewis /faddr=support@codingftp.com /body=Testing Message"

�������=�S�Y���G�E�R���E�P�W�S���W�I�X���J�R�E�Q�I���E�R�H���J�E�H�H�V���M�R�����)�Q�E�M�P���%�G�G�S�Y�R�X�����W�S���]�S�Y���H�S�R���X���R�I�I�H���X�S���I�R�X�I�V���X�L�I�Q���I�Z�I�V�]�X�M�Q�I��
SendEmail(" ���V�X�E�M�H�F�W� �7�H�V�W�L�Q�J���P�H�V�V�D�J�H���I�U�R�P���&�R�G�L�Q�J�)�7�3�����W�R� �X�V�H�U���#�D�E�F���F�R�P�����E�R�G�\�I�L�O�H� �G���?�W�H�P�S�?�W�H�V�W�L�Q�J�P�H�V�V�D�J�H���W�[�W��);

Basic Script Example:
SendEmail("/subject=Testing message from CodingFTP /to=user1@abc.com /fname=lewis /faddr=support@codingftp.com /body=Testing Message")

�����=�S�Y���G�E�R���E�P�W�S���W�I�X���J�R�E�Q�I���E�R�H���J�E�H�H�V���M�R�����)�Q�E�M�P���%�G�G�S�Y�R�X�����W�S���]�S�Y���H�S�R���X���R�I�I�H���X�S���I�R�X�I�V���X�L�I�Q���I�Z�I�V�]�X�M�Q�I��
�6�H�Q�G�(�P�D�L�O�������V�X�E�M�H�F�W� �7�H�V�W�L�Q�J���P�H�V�V�D�J�H���I�U�R�P���&�R�G�L�Q�J�)�7�3�����W�R� �X�V�H�U���#�D�E�F���F�R�P�����E�R�G�\�I�L�O�H� �G���?�W�H�P�S�?�W�H�V�W�L�Q�J�P�H�V�V�D�J�H���W�[�W����

See Also:
SendResult

4.4.4 SendResult

Description:
Send the script result via email

Options:

/always Always email the log if specified; Otherwise, only sending when error occurred.
/logfile Whether including script log in the email. Possible values:

always Always including log file in the email
error Only including log file in the email if there is any error occurred

Note:
You need to specify the SMTP server information, Recipient and "From" information at "Edit->Options-
>Email Account" before using this command.

JScript Example:
SendResult(" /always /logfile=error" );

Basic Script Example:
SendResult("/always /logfile=error")

See Also:
SendEmail
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4.5 Miscellaneous

4.5.1 ErrorText

Description:
Get the last error text

Options:
(no option)

See Also:
ErrorCode

4.5.2 ErrorCode

Description:
Get the last error code

Options:
(no option)

See Also:
ErrorText

4.5.3 GetParam

Description:
Get parameter value from command line by its name

Options:
parameter name

JScript Example:
�������-�J���]�S�Y���V�Y�R���X�L�I���W�G�V�M�T�X���Z�M�E���G�S�Q�Q�E�R�H���P�M�R�I�����G�S�H�M�R�K�J�X�T���I�\�I�����P�S�K�J�M�P�I�!�R�I�[�P�S�K�J�M�P�I���P�S�K�����8�L�I�R���J�S�P�P�S�[�M�R�K���G�S�Q�Q�E�R�H���[�M�P�P���V�I�X�Y�V�R�W�����R�I�[�P�S�K�J�M�P�I���P�S�K��
GetParam( 'logfile' ); �������=�S�Y���[�M�P�P���K�I�X�����R�I�[�P�S�K�J�M�P�I���P�S�K��

Basic Script Example:
�����-�J���]�S�Y���V�Y�R���X�L�I���W�G�V�M�T�X���Z�M�E���G�S�Q�Q�E�R�H���P�M�R�I�����G�S�H�M�R�K�J�X�T���I�\�I�����P�S�K�J�M�P�I�!�R�I�[�P�S�K�J�M�P�I���P�S�K�����8�L�I�R���J�S�P�P�S�[�M�R�K���G�S�Q�Q�E�R�H���[�M�P�P���V�I�X�Y�V�R�W�����R�I�[�P�S�K�J�M�P�I���P�S�K��
GetParam("logfile") �����=�S�Y���[�M�P�P���K�I�X�����R�I�[�P�S�K�J�M�P�I���P�S�K��

See Also:

4.5.4 ExitWidows

Description:
Exit Windows system

Options:

/logoff Log off current user
/
shutdown

Shutdown computer

/reboot Reboot computer
/now If specified, CodingFTP will take action immediately; Otherwise, a window will be displayed

to delay for 30 seconds so users have chance to cancel the operation
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JScript Example:
ExitWindows(" /logoff" );

Basic Script Example:
ExitWindows("/logoff")

See Also:

4.5.5 SetWorkingDir

Description:
Set working directory

Options:

/local Working directory on local computer
/ftp Working directory on FTP server

JScript Example:
SetWorkingDir(" ���O�R�F�D�O� �G���?�W�H�P�S�?�O�H�Z�L�V�����X�V�H�U�V���O�H�Z�L�V��);

Basic Script Example:
�6�H�W�:�R�U�N�L�Q�J�'�L�U�������O�R�F�D�O� �G���?�W�H�P�S�?�O�H�Z�L�V�����X�V�H�U�V���O�H�Z�L�V����

See Also:
GetWorkingDir

4.5.6 GetWorkingDir

Description:
Get working directory

Options:

/local Working directory on local computer
/ftp Working directory on FTP server

Result:
Local or FTP working directory

JScript Example:
GetWorkingDir(" /local" ); �������K�I�X���P�S�G�E�P���[�S�V�O�M�R�K���H�M�V�I�G�X�S�V�]
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Basic Script Example:
GetWorkingDir("/local") �����K�I�X���P�S�G�E�P���[�S�V�O�M�R�K���H�M�V�I�G�X�S�V�]

See Also:
SetWorkingDir

4.5.7 UIMsgBox

Description:
Show a message box

Options:

/msg Message
/type Icon type. Possible values:

Inform
ation
Confir
mation

When user clicked "Yes" button, it function returns "YES"; Otherwise, it returns "NO".

Warnin
g

Result:
YES
NO
OK

JScript Example:
�M�J ( UIMsgBox(" /msg=Are sure to exit? /type=Confirmation" ) == " YES" )

�������9�W�I�V���G�P�M�G�O�I�H���=�)�7���F�Y�X�X�S�R
�I�P�W�I

�������9�W�I�V���G�P�M�G�O�I�H���2�3���F�Y�X�X�S�R

Basic Script Example:
If  UIMsgBox("/msg=Are sure to exit? /type=Confirmation") = "YES" Then

�����9�W�I�V���G�P�M�G�O�I�H���=�)�7���F�Y�X�X�S�R
Else

�����9�W�I�V���G�P�M�G�O�I�H���2�3���F�Y�X�X�S�R
End If

See Also:
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4.5.8 UIAskInput

Description:
Ask user input

Options:

/prompt Prompt message
/default Default text in edit box
/passwd Password mode, show input as "*"

Result:
User input

JScript Example:
UIAskInput(" /prompt=Please input username /default=lewis" );

Basic Script Example:
UIAskInput("/prompt=Please input username /default=lewis")

See Also:

4.5.9 Uppercase

Description:
Convert all characters to upper case

Options:
(no
option)

Result:
String

JScript Example:
Uppercase("abcDE" ); �������6�I�X�Y�V�R�W�����%�&�'�(�)��

Basic Script Example:
Uppercase("abcDE") ' Returns 'ABCDE'
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4.5.10 Lowercase

Description:
Convert all characters to lower case

Options:
(no
option)

Result:
String

JScript Example:
Uppercase("abcDE" ); �������6�I�X�Y�V�R�W�����E�F�G�H�I��

Basic Script Example:
Uppercase("abcDE") ' Returns "abcde"

4.5.11 NameCase

Description:
Convert the first character in a word to uppercase and all other characters in lowercase.

Options:
(no
option)

Result:
String

JScript Example:
NameCase("my NAME" ); // Returns "My Name"

Basic Script Example:
NameCase("my NAME") ' Returns 'My Name'

4.5.12 Trim

Description:
Remove all space characters on the beginning and the end of the string. The space characters in
middle of the string will not be removed

Options:
(no
option)

Result:
String
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JScript Example:
Trim(" 123 4 " ); �������6�I�X�Y�V�R�W����������������

Basic Script Example:
Trim(" 123 4 ") ' Returns '123 4'

4.5.13 ToStr

Description:
Convert a integer value to string. It's required when you need to display the integer value. For example,
using WriteLog to output it.

Options:
(no
option)

Result:
String

JScript Example:
WriteLog(ToStr(123));

Basic Script Example:
WriteLog(ToStr(123))

4.5.14 ToNumber

Description:
Convert a string value to a number

Options:
(no
option)

Result:
String

JScript Example:
1 + ToNumber("2");  // returns 3

Basic Script Example:
1 + ToNumber("2")  ' returns 3
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5 Script HowTo

5.1 How to use variable?

For example:

Java Script
myname = "John" ;
WriteLog(myname);

Basic Script
myname = "John"
WriteLog(myname)

There are two methods to use variable in command parameter string. For example, we have two
variables:

username = "John" ;
passwd = "mypasswd" ;

Method #1: 
Normally, we need to use "+" to join these variables like this:
OpenHost( "/host=localhost /username="  + username + " /passwd="  + passwd);

The actual parameter Coding FTP get will be:
"/host=localhost /username=John /passwd=mypasswd"

Method #2:
However, Coding FTP provides another more convenient method:
OpenHost( "/host=localhost /username=$username /passwd=$passwd" );

As you can see, you can add a prefix, $, to the variable name. Coding FTP will replace them with the
real value during running.
The actual parameter Coding FTP get will be: "/host=localhost /username=John /passwd=mypasswd"
It's the same as method #1.

5.2 How to write procedure myself?

To write a custom function in Java Script, please use "function ... {...}". In VB Script, please use "Sub...
End Sub".

JScript Example:

function MyPrint(msg)
{
  MsgBox(msg);
  WriteLog(msg);
}

MyPrint( "my message" );

Basic Script Example:

Sub MyPrint(msg)
  MsgBox(msg)
  WriteLog(msg)
End Sub

MyPrint("my message")
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6 FAQ

6.1 How to run script from command line?

You can easily to integrate Coding FTP with your work flow by using command line. 

The command line is easy:

�x If the script under default script library directory, you can simply use script name  in command line:
codingftp.exe /script=script1.cfs

�x If the script file doesn't exist in default script library, you need to specify the full path  of the script
file:

codingftp.exe /script=d:\mydata\testing.cfs

6.2 How to upgrade my license?

Coding FTP has two licenses: Professional and Enterprise.

If you want to upgrade your license, please:
1) Email us at sales@codingftp.com and let us know your current license information and the license
type you want to purchase
2) We'll send you an ordering link. The price will be the difference between two editions plus $3.
3) Please using the ordering link we sent to you to complete the order. The new license information will
be sent to you within minutes
4) When you get the registration email, please click "Help->License Information" and enter new license
code
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7 Service

7.1 Script Writing Service

We provide not only CodingFTP but also Scripts Writing Service!

if you have no any knowledge about coding or you simply don't want to take time to write the script. For
either case, we are glad to write the script for you at a reasonable fee.

There are three types of script:
A Class Script : Needs less than one hour to write and debug
B Class Script : Needs less than three hours to write and debug
C Class Script : Needs less than 48 hours to write and debug

More information about SWS, please visit http://www.codingftp.com/sws.php

Note: This service is only available for registered users. If you didn't register CodingFTP yet, please 

click here to buy a license today!

7.2 Customized Version

Thanks to the excellent design of Coding FTP, we are able to expand Coding FTP easily. So we
provide this service for you. If you think Coding FTP suits most of your needs but lacks some important
features to you. Please don't hesitate to contact us. We can discuss the possibility of Customized
Version.

More information about Customized Version service, please visit http://www.codingftp.com/
customized.php
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8 Tech Support

�x Discussion Forum
   You can also post your questions on discussion forum. It's also a good place to get our support

�x Contact Form
   You can also use the online form to send message to us.

�x Email
   If you have any question or encountered any problem, you can contact our support team at 
support@codingftp.com

Note: If you are a registered users, please use the registration email to send out message so you can
get priority support.


